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Introduction

You made the right choice twice: Mac OS X Snow Leopard and this book.

Take a deep breath and get ready to have a rollicking good time. That’s right. 

This is a computer book, but it’s going to be fun. What a concept! Whether 

you’re brand spanking new to the Mac or a grizzled old Mac vet, I guaran-

tee that reading this book to discover the ins and outs of Mac OS X Snow 

Leopard will make everything easier. Wiley, Inc. (the publisher of this book) 

couldn’t say as much on the cover if it weren’t true!

About This Book
This book’s roots lie with my international bestseller Macintosh System 7.5 
For Dummies, an award-winning book so good that now-deceased Mac cloner 

Power Computing gave away a copy with every Mac clone it sold. Mac OS X 
Snow Leopard For Dummies is the latest revision and has been, once again, 

completely updated to include all the Mac OS X goodness found in Snow 

Leopard. In other words, this edition combines all the old, familiar features of 

previous editions — but is once again updated to reflect the latest and great-

est offering from Apple as well as feedback from readers.

Why write a For Dummies book about Snow Leopard? Well, Snow Leopard is a 

big, somewhat complicated, personal-computer operating system. So I made 

Mac OS X Snow Leopard For Dummies a not-so-big, not-very-complicated book 

that shows you what Snow Leopard is all about without boring you to tears, 

confusing you, or poking you with sharp objects.

In fact, I think you’ll be so darned comfortable that I wanted the title to be 

Mac OS X Snow Leopard Without Discomfort, but the publishers wouldn’t let 

me. Apparently, we For Dummies authors have to follow some rules, and using 

Dummies and Mac OS X Snow Leopard in this book’s title are among them.

And speaking of “dummies,” remember that it’s just a word. I don’t think you’re 

dumb — quite the opposite! My second choice for this book’s title was Mac 
OS X Snow Leopard For People Smart Enough to Know They Need Help with It, 
but you can just imagine what Wiley thought of that. (“C’mon, that’s the whole 

point of the name!” they insisted. “Besides, it’s shorter our way.”)
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2 Mac OS X Snow Leopard For Dummies 

Anyway, the book is chock-full of information and advice, explaining every-

thing you need to know about Mac OS X in language you can understand — 

along with timesaving tips, tricks, techniques, and step-by-step instructions, 

all served up in generous quantities.

What You Won’t Find in This Book
Another rule we For Dummies authors must follow is that our books cannot 

exceed a certain number of pages. (Brevity is the soul of wit, and all that.) 

So I wish I could have included some things, but they didn’t fit. Although I 

feel confident you’ll find everything you need to know about Mac OS X Snow 

Leopard in this book, some things bear further looking into, including these:

 ✓ Information about some of the applications (programs) that come with 

Mac OS X Snow Leopard: An installation of Mac OS X Snow Leopard 

includes more than 50 separate applications, mostly found in the 

Applications folder and the Utilities folder within it. I’d love to walk you 

through each one of them, but that would have required a book a whole 

lot bigger, heavier, and more expensive than this one.

  This book is, first and foremost, about using Mac OS X, so I brief you on 

the small handful of bundled applications essential to using Mac OS X 

Snow Leopard and keep the focus there — namely, iCal, Address Book, 

Mail, Safari, TextEdit, and the like, as well as important utilities you may 

need to know how to use someday.

  For what it’s worth, many books cover the applications that come with 

Mac OS X Snow Leopard as well as applications commonly bundled with 

Snow Leopard on a new Mac, such as iLife; the one my publisher sug-

gested I recommend is Mac OS X Snow Leopard All-in-One For Dummies, 
written by Mark L. Chambers, which is (by sheer coincidence, of course) 

also published by Wiley.

 ✓ Information about Microsoft Office, iLife, iWork, Adobe Photoshop, 

Quicken, and most other third-party applications: Okay, if all the gory 

details of all the bundled (read: free) Mac OS X Snow Leopard applica-

tions don’t fit here, I think you’ll understand why digging into third-party 

applications that cost extra was out of the question.

 ✓ Information about programming for the Mac: This book is about using 
Mac OS X Snow Leopard, not writing code for it. Dozens of books cover 

programming on the Mac, most of which are two or three times the size 

of this book.

  For what it’s worth, Dennis Cohen, my technical editor, and his brother 

Michael wrote a great book about Xcode 3, the development environment 

included with Mac OS X Snow Leopard. It’s called The Xcode 3 Book and, 

by sheer coincidence, is also published by (who else?) Wiley.
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Conventions Used in This Book
To get the most out of this book, you need to know how I do things and why. 

Here are a few conventions I use in this book to make your life easier:

 ✓ When I want you to open an item in a menu, I write something like 

“Choose File➪Open,” which means, “Pull down the File menu and 

choose the Open command.”

 ✓ Stuff you’re supposed to type appears in bold type, like this.

 ✓ Sometimes an entire a sentence is in boldface, as you see when I pres-

ent a numbered list of steps. In those cases, I leave the bold off what 

you’re supposed to type, like this.

 ✓ Web addresses, programming code (not much in this book), and things 

that appear on-screen are shown in a special monofont typeface, like 
this.

 ✓ For keyboard shortcuts, I write something like Ô+A, which means to hold 

down the Ô key (the one with the little pretzel and/or Ú symbol on it) and 

then press the A key on the keyboard. If you see something like Ô+Shift+A, 

that means to hold down the Ô and Shift keys while pressing the A key. 

Again, for absolute clarity, I never refer to the Ô key with the Ú symbol. I 

reserve that symbol for the Ú menu (Apple menu). For the Command key, 

I use only the Ô symbol. Got it? Very cool.

Foolish Assumptions
Although I know what happens when you make assumptions, I’ve made a few 

anyway. First, I assume that you, gentle reader, know nothing about using 

Mac OS X — beyond knowing what a Mac is, that you want to use OS X, that 

you want to understand OS X without having to digest an incomprehensible 

technical manual, and that you made the right choice by selecting this 

particular book.

And so I do my best to explain each new concept in full and loving detail. 

Maybe that’s foolish, but . . . oh well.

Oh, and I also assume that you can read. If you can’t, ignore this paragraph.
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How This Book Is Organized
Mac OS X Snow Leopard For Dummies is divided into six logical parts, num-

bered (surprisingly enough) 1 through 6. By no fault of mine, they’re numbered 

using those stuffy old Roman numerals, so you see I–VI where you (in my 

humble opinion) ought to see Arabic numbers 1–6. It’s another rule that For 
Dummies authors have to follow, I think.

Anyway, it’s better if you read the parts in order, but if you already know a lot — 

or think you know a lot — feel free to skip around and read the parts that 

interest you most.

Part I: Introducing Mac OS X Snow Leopard: The Basics: This first part is 

very, very basic training. From the mouse to the Desktop, from menus, win-

dows, and icons to the snazzy-but-helpful Dock, it’s all here. A lot of what you 

need to know to navigate the depths of Mac OS X safely (and sanely) and per-

form basic tasks can be found in this part. And although old-timers might just 

want to skim through it, newcomers should probably read every word. Twice.

Part II: Snow Leopard Taming (Or “Organization for Smart People”): In 

this part, I build on the basics of Part I and really get you revving with your 

Mac. Here, I cover additional topics that every Mac user needs to know, 

coupled with some hands-on, step-by-step instructions. The part starts with 

a closer look at ways you can organize your files and folders, followed by a 

chapter about using removable media (which means ejectable discs — mostly 

CDs and DVDs). Last, but certainly not least, is a chapter about all the Snow 

Leopard applications (such as iCal, Address Book, and Mail) that help you 

keep your digital life organized.

Part III: Do Unto Snow Leopard: Getting Things Done: This part is chock-full 

of ways to do productive stuff with your Mac. In this section, you discover 

the Internet first — or at least how to get it working on your Mac and what to 

do with it after you do. Next, you look at the digital-media side of things with 

chapters about music, video, games, and digital photos. Finally, you look at 

Snow Leopard’s built-in tools for writing — namely, TextEdit and fonts.

Part IV: Making This Snow Leopard Your Very Own: Here I get into the nitty-

gritty underbelly of making Mac OS X Snow Leopard work the way you want it 

to work. I start with the ins and outs of printing under OS X. Then I move on 

to somewhat more advanced topics, such as file sharing, creating and using 

multiple user accounts (and why you might want to), and the lowdown on 

numerous Mac OS X Snow Leopard features — Text to Speech, speech recog-

nition, automation, and more — that can make your computing experience 

even more pleasant.
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5 Introduction

Part V: The Care and Feeding of Your Snow Leopard: This part starts with 

a chapter about backups and security, which not only stresses the impor-

tance of backing up your data, but also shows you how to do it almost pain-

lessly. Then I introduce you to a handful of useful utilities included with Snow 

Leopard, and explain when and how to use them. Finally, I tell you how to 

avoid most disasters, as well as what to do in the unlikely event that a major 

mishap does occur.

Part VI: The Part of Tens: Finally, it’s The Part of Tens, which might have 

started life as a Letterman rip-off, but does include heaping helpings of tips, 

optional software, great Mac Web sites, and hardware ideas.

Appendix: Last, but certainly not least, I cover installing Mac OS X Snow 

Leopard in the appendix. The whole process has become quite easy with this 

version of the system software, but if you have to install Snow Leopard your-

self, it would behoove you to read this helpful appendix first.

Icons Used in This Book
Little round pictures (icons) appear off to the left side of the text throughout 

this book. Consider these icons miniature road signs, telling you a little some-

thing extra about the topic at hand. Here’s what the different icons look like 

and what they all mean.

 Look for Tip icons to find the juiciest morsels: shortcuts, tips, and undocu-

mented secrets about Snow Leopard. Try them all; impress your friends!

 When you see this icon, it means that this particular morsel is something that 

I think you should memorize (or at least write on your shirt cuff).

 Put on your propeller-beanie hat and pocket protector; these parts include the 

truly geeky stuff. It’s certainly not required reading, but it must be interesting 

or informative, or I wouldn’t have wasted your time with it.

 Read these notes very, very, very carefully. (Did I say very?) Warning icons flag 

important cautionary information. The author and publisher won’t be respon-

sible if your Mac explodes or spews flaming parts because you ignored a 

Warning icon. Just kidding. Macs don’t explode or spew (with the exception of 

a few choice PowerBook 5300s, which won’t run Snow Leopard anyway). But I 

got your attention, didn’t I? I’ll tell you once again: It is a good idea to read the 

Warning icons very carefully.
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6 Mac OS X Snow Leopard For Dummies 

 These icons represent my ranting or raving about something that either bugs 

me or makes me smile. When I’m ranting, imagine foam coming from my 

mouth. Rants are required to be irreverent, irrelevant, or both. I try to keep 

them short, more for your sake than mine.

 Well, now, what could this icon possibly be about? Named by famous editorial 

consultant Mr. Obvious, this icon highlights all things new and different in Mac 

OS X Snow Leopard.

Where to Go from Here
Go to a comfortable spot (preferably not far from a Mac) and read the book.

The first few chapters of this book are where I describe the basic everyday 

things that you need to understand to operate your Mac effectively. If you’re 

new to Macs and OS X Snow Leopard, start there.

Even though Mac OS X Snow Leopard is way different from previous Mac 

operating systems, the first part of the book is so basic that if you’ve been 

using a Mac for long, you might think you know it all — and okay, you might 

know most of it. But hey! Not-so-old-timers need a solid foundation. So here’s 

my advice: Skip the stuff you know; you’ll get to the better stuff faster.

 I didn’t write this book for myself. I wrote it for you — and would love to hear 

how it worked for you. So please send me your thoughts, platitudes, likes and 

dislikes, and any other comments. You can send snail-mail in care of Wiley, but 

it takes a long time to reach me that way, and I just don’t have time to respond 

to 99.9% of it. If you want a response your best bet is to send e-mail to me 

directly at SnowLeopard4Dummies@boblevitus.com. I appreciate your 

feedback, and I try to respond to all reasonably polite e-mail within a few days.

Did this book work for you? What did you like? What didn’t you like? What 

questions were unanswered? Did you want to know more about something? 

Did you want to find out less about something? Tell me! I have received more 

than 100 suggestions about previous editions, most of which are incorpo-

rated here. So keep up the good work!

So what are you waiting for? Go — enjoy the book!
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Part I
Introducing Mac OS X 

Snow Leopard: 
The Basics
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In this part . . .

Because I believe it’s important to crawl before you 
walk, in this part you get a look at the most basic of 

basics — such as how to turn on your Mac. Next, I 
acquaint you with the Mac OS X Finder, with its Desktop, 
windows, icons, and menus (oh my)! Then you find out 
how to make this cat your own by customizing your work 
environment to suit your style. After that is a date with 
the Dock. And last but certainly not least, you discover 
some additional tasks that will make life with Snow 
Leopard ever so much easier.

So get comfortable, roll up your sleeves, fire up your Mac 

if you like, and settle down with Part I, a delightful little 

section I like to think of as “The Hassle-Free Way to Get 

Started with Mac OS X Snow Leopard.”
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Chapter 1

Mac OS X Snow Leopard 101 
(Prerequisites: None)

In This Chapter
▶ Understanding what an operating system is and is not

▶ Turning on your Mac

▶ Getting to know the startup process

▶ Turning off your Mac

▶ Avoiding major Mac mistakes

▶ Pointing, clicking, dragging, and other uses for your mouse

▶ Getting help from your Mac

Congratulate yourself on choosing Mac OS X, which stands for Macintosh 

Operating System X — that’s the Roman numeral ten, not the letter X 
(pronounced ten, not ex). You made a smart move because you scored more 

than just an operating-system upgrade. Mac OS X Snow Leopard includes 

several new features to make using your Mac easier, and dozens of improve-

ments that help you do more work in less time.

In this chapter, I start at the very beginning and talk about Mac OS X in 

mostly abstract terms; then I move on to explain what you need to know to 

use Mac OS X Snow Leopard successfully.

If you’ve been using Mac OS X for a while, some of the information in this chapter 

might seem hauntingly familiar; some features that I describe haven’t changed 

from earlier versions of Mac OS X. But if you decide to skip this chapter because 

you think you have all the new stuff figured out, I assure you that you’ll miss 

at least a couple of things that Apple didn’t bother to tell you (as if you read 

every word in Mac OS X Help, the only user manual Apple provides, anyway!).

Tantalized? Let’s rock.
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 If you’re about to upgrade to Snow Leopard from an earlier version of Mac OS X, 

I feel obliged to mention a major pitfall to avoid: One very specific misplaced 

click, done while installing your new OS, could erase every file on your hard 
drive. The appendix describes this situation in full and loving detail, and it 

contains other important information about installing Snow Leopard that can 

make upgrading a more pleasant experience.

Gnawing to the Core of OS X
The operating system (that is, the OS in Mac OS X) is what makes a Mac a 

Mac. Without it, your Mac is a pile of silicon and circuits — no smarter than a 

toaster.

“So what does an operating system do?” you ask. Good question. The short 

answer is that an operating system controls the basic and most important 

functions of your computer. In the case of Mac OS X and your Mac, the 

operating system

 ✓ Manages memory

 ✓ Controls how windows, icons, and menus work

 ✓ Keeps track of files

 ✓ Manages networking

 ✓ Does housekeeping (No kidding!)

Other forms of software, such as word processors and Web browsers, rely on 

the operating system to create and maintain the environment in which they 

work their magic. When you create a memo, for example, the word processor 

provides the tools for you to type and format the information. In the background, 

the operating system is the muscle for the word processor, performing crucial 

functions such as the following:

 ✓ Providing the mechanism for drawing and moving the on-screen window 

in which you write the memo

 ✓ Keeping track of a file when you save it

 ✓ Helping the word processor create drop-down menus and dialogs for 

you to interact with

 ✓ Communicating with other programs

 ✓ And much, much more (stuff that only geeks could care about)
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So, armed with a little background in operating systems, take a gander at the 

next section before you do anything else with your Mac.

One last thing: As I mention in the introduction (I’m only repeating it here in 

case you normally don’t read introductions), Mac OS X Snow Leopard comes 

with more than 50 applications. And though I’d love to tell you all about each 

and every one, I have only so many pages at my disposal. If you need more 

info on the programs I don’t cover, may I (again) recommend Mac OS X Snow 
Leopard All-in-One For Dummies, written by Mark L. Chambers; iLife All-in-
One For Dummies, written by my old friends Tony Bove and Cheryl Rhodes; 

or iMovie & iDVD ’09 For Dummies by the technical editor of this very book, 

Dennis Cohen, and his brother Michael (all three titles are from Wiley).

The Mac advantage
Most of the world’s personal computers use 
Microsoft Windows. But you’re among the 
lucky few to have a computer with an operating 
system that’s intuitive, easy to use, and (dare 
I say?) fun. If you don’t believe me, try using 
Windows for a day or two. Go ahead. You prob-
ably won’t suffer any permanent damage. In 
fact, you’ll really begin to appreciate how good 
you have it. Feel free to hug your Mac. Or give 
it a peck on the disc-drive slot — just try not to 
get your tongue caught.

As someone once told me, “Claiming that the 
Macintosh is inferior to Windows because 
most people use Windows is like saying that 
all other restaurants serve food that’s inferior 
to McDonald’s.”

We might be a minority, but Mac users have 
the best, most stable, most modern all-purpose 
operating system in the world, and here’s why: 
UNIX — on which Mac OS X is based — is 
widely regarded as the best industrial-strength 
operating system on the planet. For now, just 

know that being based on UNIX means that a 
Mac running OS X will crash less often than 
an older Mac or a Windows machine, which 
means less downtime. And being UNIX-based 
also means far fewer viruses and malicious 
software. But perhaps the biggest advantage 
OS X has is that when an application crashes, 
it doesn’t crash your entire computer, and you 
don’t have to restart the whole computer to 
continue working.

By the way, with the advent of Intel-powered 
Macs a few years ago, you can now run 
Windows natively. That’s right — you can now 
install and run Microsoft Windows on any Mac 
powered by an Intel processor, as described in 
Chapter 16.

Don’t let that UNIX stuff scare you. It’s there 
if you want it, but if you don’t want it or don’t 
care (like most of us), you’ll rarely even know 
it’s there. All you’ll know is that your Mac just 
runs and runs and runs without crashing and 
crashing and crashing.
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A Safety Net for the Absolute 
Beginner (Or Any User)

In the following sections, I deal with the stuff that the manual that came with 

your Mac doesn’t cover — or doesn’t cover in nearly enough detail. If you’re a 

first-time Macintosh user, please, please read this section of the book carefully —

it could save your life. Okay, okay, perhaps I’m being overly dramatic. What 

I mean to say is that reading this section could save your Mac. Even if you’re 

an experienced Mac user, you might want to read this section anyway. Chances 

are good that you’ll see at least a few things you might have forgotten that 

might come in handy.

Turning the dang thing on
Okay. This is the big moment — turning on your Mac! Gaze at it longingly first 

and say something cheesy, such as “You’re the most awesome computer I’ve 

ever known.” If that doesn’t turn on your Mac (and it probably won’t), keep 

reading.

Apple, in its infinite wisdom, has manufactured Macs with power buttons on 

every conceivable surface: on the front, side, and back of the computer itself, 

and even on the keyboard or monitor.

So if you don’t know how to turn on your Mac, don’t feel bad — just look in 

the manual or booklet that came with your Mac. It’s at least one thing that 

the documentation always covers.

  These days, most Macs have a power-on button near the keyboard (notebooks) 

or the back side (iMacs). It usually looks like the little circle thingie you see in 

the margin.

 Don’t bother choosing Help➪Mac Help, which opens the Help Viewer program, 

because it can’t tell you where the switch is. Although the Help program is 

good for finding out a lot of things, the location of the power switch isn’t 

among them. Of course, if you haven’t found the switch and turned on the Mac, 

you can’t access Help anyway. (D’oh!)

What you should see on startup
When you finally do turn on your Macintosh, you set in motion a sophisticated 

and complex series of events that culminates in the loading of Mac OS X and 

the appearance of the Mac OS X Desktop. After a small bit of whirring, 
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13 Chapter 1: Mac OS X Snow Leopard 101 (Prerequisites: None)

buzzing, and flashing (meaning that the operating system is loading), OS X 

first tests all your hardware — slots, ports, disks, random-access memory 

(RAM), and so on. If everything passes, you hear a pleasing musical tone and 

see the tasteful gray Apple logo in the middle of your screen, along with a 

small spinning-pinwheel cursor somewhere on the screen. Both are shown in 

Figure 1-1.

 

Figure 1-1: 
This is what 
you’ll see if 
everything 

is fine 
and dandy 
when you 
turn your 
Mac on.

 

Here are the things that might happen when you power up your Mac:

 ✓ Everything is fine and dandy: Next, you might or might not see the 

Mac OS X login screen, where you enter your name and password. If you 

do, press Return or Enter (after you type your name and password, of 

course), and away you go.

  If you don’t want to have to type your name and password every time 

you start or restart your Mac (or even if you do), check out Chapter 16 

for the scoop on how to turn the login screen on or off.

  Either way, the Desktop soon materializes before your eyes. If you 

haven’t customized, configured, or tinkered with your Desktop, it should 

look pretty much like Figure 1-2. Now is a good time to take a moment 

for positive thoughts about the person who convinced you that you 

wanted a Mac. That person was right!

 ✓ Blue/black/gray screen of death: If any of your hardware fails when it’s 

tested, you might see a blue, black, or gray screen.

  Some older Macs played the sound of a horrible car wreck instead of the 

chimes, complete with crying tires and busting glass. It was exception-

ally unnerving, which might be why Apple doesn’t use it anymore.

  The fact that something went wrong is no reflection on your prowess as 

a Macintosh user. Something is broken, and your Mac may need repairs. 

If this is happening to you right now, check out Chapter 19 to try to get 

your Mac well again.
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Figure 1-2: 
The Mac OS 

X Desktop 
after a 
brand-

spanking-
new 

installation 
of OS X.

 

  If your computer is under warranty, dial 1-800-SOS-APPL, and a customer-

service person can tell you what to do. Before you do anything, though, 

skip ahead to Chapter 19. It’s entirely possible that one of the sugges-

tions there can get you back on track without your having to spend even 

a moment on hold.

  ✓ Prohibitory sign (formerly known as the flashing-question-mark disk): 

Most users eventually encounter the prohibitory sign shown in the left 

margin (which replaced the flashing question-mark-on-a-disk icon and 

flashing folder icon back in Mac OS X Jaguar). This icon means your Mac 

can’t find a startup disk, hard drive, network server, or DVD-ROM con-

taining a valid Macintosh operating system. See Chapter 19 for ways you 

can try to ease your Mac’s ills.

 ✓ Kernel panic: You shouldn’t see this very often, but you might occasion-

ally see a block of text in four languages, including English, as shown in 

Figure 1-3. This means that your Mac has experienced a kernel panic, the 

most severe type of system crash. If you restart your Mac and see this 

message again, look in Chapter 19 for a myriad of possible cures for all 

kinds of ailments, including this one.
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Figure 1-3: 
If this is 

what you’re 
seeing, 

things are 
definitely 

not fine and 
dandy. 

 

 How do you know which version of the Mac OS your computer has? Simple: 

 1. Choose About This Mac from the Ú menu (the menu with the Ú 

symbol in the upper-left corner of the menu bar). 

  The About This Mac window pops up on your screen, as shown in 

Figure 1-4. The version you’re running appears just below Mac OS X in 

the center of the window. Version 10.6 is the release we know as Snow 

Leopard. 

  If you’re curious or just want to impress your friends, Mac OS X version 10.5 

was known as Leopard; 10.4 as Tiger; 10.3 as Panther; 10.2 as Jaguar; 10.1 as 

Puma; and 10.0 as Cheetah.

The legend of boot
Boot this. Boot that. “I booted my Mac and. . . .” 
or “Did it boot?” and so on. Talking about com-
puters for long without hearing the boot word is 
nearly impossible.

But why boot? Why not shoe or shirt or even 
shazam?

Back in the very olden days — say 1958 or a 
little earlier — starting up a computer required 
you to toggle little manual switches on the 
front panel, which began an internal process 
that loaded the operating system. The process 
became known as bootstrapping because if you 
toggled the right switches, the computer would 

“pull itself up by its bootstraps.” This phrase 
didn’t take long to transmogrify into booting and 
finally to boot.

Over the years, booting has come to mean turn-
ing on almost any computer or even a periph-
eral device, such as a printer. Some people 
also use it to refer to launching an application: 
“I booted Excel.”

So the next time one of your gearhead friends 
says the b-word, ask whether he knows where 
the term comes from. Then dazzle him with the 
depth and breadth of your (not-quite-useful) 
knowledge!
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 2. Click the More Info button to launch the System Profiler application.

  This app shows you much more information, including bus speed, number 

of processors, caches, installed memory, networking, storage devices, and 

much more. You can find more about this useful program in Chapter 18.

 

Figure 1-4: 
See which 
version of 
Mac OS X 

you’re 
running.

 

Shutting down properly
Turning off the power without shutting down your Mac properly is one of the 

worst things you can do to your poor Mac. Shutting down your Mac improp-

erly can really screw up your hard drive, scramble the contents of your most 

important files, or both.

 If a thunderstorm is rumbling nearby or you’re unfortunate enough to have 

rolling blackouts where you live, you might really want to shut down your 

Mac. (See the next section, where I briefly discuss lightning and your Mac.)

 To turn off your Mac, always use the Shut Down command on the Ú menu 

(which I discuss in Chapter 4) or shut down in one of these kind-and-gentle 

ways:

 ✓ Press the Power key once and then click the Shut Down button.

 ✓ On keyboards that don’t have a Power key, press Control+Eject instead — 

and then click the Shut Down button that appears (or press the Return 

key, which does the same thing).

Of course, most Mac users have broken this rule several times without any-

thing horrible happening — but don’t be lulled into a false sense of security. 

Break the rules one time too many (or under the wrong circumstances), and 

your most important file will be toast. The only time you should turn off your 

Mac without shutting down properly is when your screen is frozen or when 

your system crashed and you’ve already tried everything else. (See Chapter 19 
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for what those “everything elses” are.) A really stubborn crash doesn’t happen 

often — and less often under OS X than ever before — but when it does, forcing 

your Mac to turn off and then back on might be the only solution.

A few things you should definitely 
NOT do with your Mac
In this section, I cover the bad stuff that can happen to your computer if you 

do the wrong things with it. If something bad has already happened to you — 

I know . . . I’m beginning to sound like a broken record — see Chapter 19.

 ✓ Don’t unplug your Mac when it’s turned on. Very bad things can 

happen, such as having your operating system break. See the preceding 

section, where I discuss shutting down your system properly.

 ✓ Don’t use your Mac when lightning is near. Here’s a simple life equa-

tion for you: Mac + lightning = dead Mac. ’Nuff said. Oh, and don’t place 

much faith in inexpensive surge protectors. A good jolt of lightning will 

fry the surge protector right along with your computer — as well as pos-

sibly frying your modem, printer, and anything else plugged into it. Some 

surge protectors can withstand most lightning strikes, but those war-

riors aren’t the cheapies that you buy at your local computer emporium. 

Unplugging your Mac from the wall during electrical storms is safer and 

less expensive. (Don’t forget to unplug your external modem, network 

hubs, printers, and other hardware that plugs into the wall, as well — 

lightning can fry them, too.)

 ✓ Don’t jostle, bump, shake, kick, throw, dribble, or punt your Mac, 

especially while it’s running. Your Mac contains a hard drive that spins 

at 4,200 revolutions per minute (rpm) or more. A jolt to a hard drive 

while it’s reading or writing a file can cause the head to crash into the 

disk, which can render many — or all — files on it unrecoverable. Ouch!

 ✓ Don’t forget to back up your data! If the stuff on your hard drive means 

anything to you, you must back it up. Not maybe. You must. Even if your 

most important file is your last saved game of Call of Duty 2, you still 

need to realize how important it is to back up your files. Fortunately, 

Mac OS X Snow Leopard includes an awesome backup utility called Time 

Machine. (Unfortunately, you need either an external hard drive or an 

Apple Time Capsule device to take advantage of it.) So I beg you: Please 

read Chapter 17 now and find out how to back up before something hor-

rible happens to your valuable data!

  I strongly recommend that you read Chapter 17 sooner rather than later — 

preferably before you do any significant work on your Mac. Dr. Macintosh 

says, “There are only two kinds of Mac users: those who have never lost 

data and those who will.” Which kind do you want to be?
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 ✓ Don’t kiss your monitor while wearing stuff on your lips. For obvious rea-

sons! Use a soft cloth and/or OmniCleanz display cleaning solution (I love 

the stuff, made by RadTech; www.radtech.us) to clean your display.

Point-and-click boot camp
Are you new to the Mac? Just figuring out how to move the mouse around? Now 

is a good time to go over some fundamental stuff that you need to know for just 

about everything you’ll be doing on the Mac. Spend a few minutes reading this 

section, and soon you’ll be clicking, double-clicking, pressing, and pointing all 

over the place. If you think you have the whole mousing thing pretty much 

figured out, feel free to skip this section. I’ll catch you on the other side.

Still with me? Good. Now for some basic terminology:

 ✓ Point: Before you can click or press anything, you have to point to it. 

Place your hand on your mouse and move it so that the cursor arrow is 

over the object you want — like on top of an icon or a button. 

 ✓ Click: Also called single-click. Use your index finger to push the mouse 

button all the way down and then let go so the button produces a satis-

fying clicking sound. (If you have one of the new optical Apple Pro mice, 

you push down the whole thing to click.) Use a single-click to highlight 

an icon, press a button, or activate a check box or window.

  In other words, first you point and then you click — point and click, in 

computer lingo.

Eternally yours . . . now
Mac OS X is designed so you never have to 
shut it down. You can configure it to sleep after 
a specified period of inactivity. (See Chapter 
16 for more info on the Energy Saver features 
of OS X.) If you do so, your Mac will consume 
very little electricity when it’s sleeping and will 
usually be ready to use (by pressing any key or 
clicking the mouse) in less than a minute. On 
the other hand, if you’re not going to be using it 
for a few days, you might want to shut it down 
anyway.

Note: If you leave your Mac on constantly and 
you’re gone when a lightning storm or rolling 

blackout hits, your Mac might get wasted. So 
be sure you have adequate protection — say, 
a decent surge protector designed specifically 
for computers — if you decide to leave your 
Mac on and unattended for long periods. See 
the section “A few things you should definitely 
NOT do with your Mac,” elsewhere in this 
chapter, for more info on lightning and your 
Mac. Frankly, if I plan to be away from mine for 
more than a day, I usually shut it down, just in 
case. But because OS X is designed to run 24/7, 
I don’t shut it down at night unless the night 
happens to be dark and stormy.
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 ✓ Double-click: Click twice in rapid succession. With a little practice, you 

can perfect this technique in no time. Use a double-click to open a folder 

or to launch a file or application.

 ✓ Control+click: Hold down the Control key while single-clicking. 

Control+clicking is the same as right-clicking a Windows system and 

displays a menu (called a contextual menu) where you Control+clicked. 

In fact, if you’re blessed with a two-or-more-button mouse such as the 

Apple Mighty Mouse, you can right-click and avoid having to hold down 

the Control key.

  I use the five-button Microsoft IntelliMouse Explorer 3.0 and recommend 

it highly.

 ✓ Drag: Dragging something usually means you have to click it first and 

hold down the mouse button. Then you move the mouse on your desk 

or mouse pad so the cursor and whatever you select move across the 

screen. The combination of holding down the button and dragging the 

mouse is usually referred to as click and drag.

 ✓ Choosing an item from a menu: To get to Mac OS menu commands, you 

must first open a menu and then pick the option you want. Point at the 

name of the menu you want with your cursor, press the mouse button 

down, and then drag downward until you select the command you want. 

When the command is highlighted, finish selecting by letting go of the 

mouse button.

 If you’re a longtime Mac user, you probably hold down the mouse button the 

whole time between clicking the name of the menu and selecting the command 

you want. You can still do it that way, but you can also click the menu name to 

open it, release the mouse button, drag down to the item you want to select, 

and then click again. In other words, OS X menus stay open after you click 

them, even if you’re not holding down the mouse button. After you click a menu 

to open it, you can even type the first letter (or letters) of the item to select it 

and then execute that item by pressing the Spacebar or the Return or Enter key. 

A menu remains open until you click something else. 

Go ahead and give it a try . . . I’ll wait.

Not Just a Beatles Movie: 
Help and the Help Menu

One of the best features about all Macs is the excellent built-in help, and Mac 

OS X doesn’t cheat you on that legacy: This system has online help in abun-

dance. When you have a question about how to do something, the Mac Help 

Center is the first place you should visit (after this book, of course).
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Clicking the Help menu reveals the Search Help field at the top of the menu 

and the Mac Help item, which opens the Mac Help window, as shown in 

Figure 1-5.

 

Figure 1-5: 
Mac Help 

is nothing if 
not helpful.

 

The keyboard shortcut for Help appears on the Help menu as Ô+?, but you 

really need to press $+Ô+? to open Help through the keyboard. 

 Just so you know, this is the only shortcut I can think of where the menu doesn’t 

display an up-arrow ($+Ô+?) to let you know you need to press Shift.

You can find out much more about keyboard shortcuts in Chapter 2.

To use Mac Help, simply type a word or phrase into the text field at the top 

right and then press Return or Enter. In a few seconds, your Mac provides 

you one or more articles to read, which (theoretically) are related to your 

question. Usually. For example, if you type menus and press Return, you get 

15 different help topics, as shown in Figure 1-6.
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Figure 1-6: 
You have 

questions? 
Mac has 
answers.

 

Now, here’s a cool feature I like to call automatic visual help cues. Here’s how 

they work:

 1. Type a word or phrase in the Help menu’s Search field.

 2. Select any item that has a menu icon to its left (such as the Secure 

Empty Trash item in Figure 1-7).

  The automatic visual cue — an arrow — appears, pointing at that 

command in the appropriate menu.
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Figure 1-7: 
If you 

choose an 
item with a 
menu icon, 

an arrow 
points to 

that item in 
context. 

 

 Although you don’t have to be connected to the Internet to use Mac Help, you 

do need an Internet connection to get the most out of it. (Chapter 9 can help 

you set up an Internet connection, if you don’t have one.) That’s because OS X 

installs only certain help articles on your hard drive. If you ask a question 

that those articles don’t answer, Mac Help connects to Apple’s Web site and 

downloads the answer (assuming that you have an active Internet connection). 

These answers are the “Support Articles,” denoted by a plus sign (as shown in 

the lower part of the window in Figure 1-6, earlier in this chapter). Click one of 

these entries, and Help Viewer retrieves the text over the Internet. Although 

this can sometimes be inconvenient, it’s also quite smart. This way Apple can 

update the Help system at any time without requiring any action from you.

Furthermore, after you’ve asked a question and Mac Help has grabbed the 

answer from the Apple Web site, the answer remains on your hard drive 

forever. If you ask for it again — even at a later date — your computer won’t 

have to download it from the Apple Web site again.
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Chapter 2

The Desktop and Windows 
and Menus (Oh My)!

In This Chapter
▶ Checking out the parts of a window

▶ Dealing with dealie-boppers in windows

▶ Resizing, moving, and closing windows

▶ Getting comfortable with menu basics

This chapter introduces important features of Mac OS X, starting with the 

first thing you see when you log in — the Finder and its Desktop. After a 

quick look around the Desktop, you get a look into two of its most useful fea-

tures: windows and menus.

Windows are (and have always been) an integral part of Macintosh comput-

ing. Windows in the Finder (or, as a PC user would say, “on the Desktop”) show 

you the contents of the hard drive, optical drive, flash (thumb) drive, network 

drive, disk image, and folder icons; windows in applications do many things. 

The point is that windows are part of what makes your Mac a Mac; knowing 

how they work — and how to use them — is essential.

Menus are another quintessential part of the Macintosh experience. The 

latter part of this chapter starts you out with a few menu basics. As needed, 

I direct you to other parts of the book for greater detail. So relax and don’t 

worry. By the end of this chapter, you’ll be ready to work with windows and 

menus in any application that uses them (and most applications, games 

excluded, do).
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Touring the Finder and Its Desktop
The Finder is the program that creates the Desktop, keeps track of your files 

and folders, and is always running. Just about everything you do on your Mac 

begins and ends with the Finder. It’s where you manage files, store documents, 

launch programs, and much more. If you ever expect to master your Mac, the 

first step is to master the Finder and its Desktop. Check out the default Mac 

Finder and Desktop for Mac OS X Snow Leopard in Figure 2-1.

The Finder is the center of your Mac OS experience, so before I go any further, 

here’s a quick description of its most prominent features:

 ✓ Desktop: The Desktop is the area behind the windows and the Dock, where 

your hard-drive icon (ordinarily) lives. The Desktop isn’t a window, yet it 

acts like one. Like a folder window or drive window, the Desktop can 

contain icons. But unlike most windows, which require a bit of navigation 

to get to, the Desktop is a great place for things you use a lot, such as 

folders, applications, or particular documents.

 

Figure 2-1: 
The default 

Snow 
Leopard 

Finder and 
Desktop.

 

Menu Window Icons

DesktopDock
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  Some folks use the terms Desktop and Finder interchangeably to refer to 

the total Macintosh environment you see after you log in — the icons, 

windows, menus, and all that other cool stuff. Just to make things confus-

ing, the background you see on your screen — the picture behind your 

hard-drive icon and your open windows — is also called the Desktop. In 

this book, I refer to the application you use when the Desktop is showing 

as the Finder. When I say Desktop, I’m talking about the picture back-

ground behind your windows and the Dock, which you can use as a stor-

age place for icons if you want.

  To make things even more confusing, the Desktop is a full-screen rep-

resentation of the icons in the Desktop folder inside your Home folder. 

Don’t panic — this is all explained in more detail in Chapter 6. 

 ✓ Dock: The Dock is the Finder’s main navigation shortcut tool. It makes 

getting to frequently used icons easy, even when you have a screen full 

of windows. Like the Desktop, the Dock is a great place for things you 

use a lot, such as folders, applications, or particular documents. Besides 

putting your frequently used icons at your fingertips, it’s almost infinitely 

customizable; read more about it in Chapter 4.

 ✓ Icons: Icons are the little pictures you see in your windows and even on 

your Desktop. Most icons are containers for things you work with on 

your Mac, such as programs and documents, which are also represented 

by — you guessed it — icons.

 ✓ Windows: Opening most icons (by double-clicking them) makes a 

window appear. Windows in the Finder show you the contents of hard-

drive and folder icons, and windows in applications usually show you 

the contents of your documents. In the sections that follow, you can find 

the full scoop on Snow Leopard windows, which are very different from 

Mac windows in previous OS releases.

 ✓ Menus: Menus let you choose to do things, such as create new folders; 

duplicate files; cut, copy, or paste text; and so on. I introduce menu 

basics later in this chapter; you find details about working with menus 

for specific tasks throughout this book.

Whereas this section offers a basic introduction to the Finder and Desktop, 

Chapter 5 explains in detail how to navigate and manage your files in the 

Finder. You find out how to use the Finder toolbar, navigate folders and sub-

folders, and switch among views, among other things. But before you start 

using the Finder, it will help you to know the basics of working with windows 

and menus; if these Mac features are new to you, I suggest you read all of this 

chapter and pay special attention to Chapter 5 later.

06_435434-ch02.indd   2506_435434-ch02.indd   25 8/6/09   8:44:25 PM8/6/09   8:44:25 PM



26 Part I: Introducing Mac OS X Snow Leopard: The Basics 

Anatomy of a Window
Windows are a ubiquitous part of using a Mac. When you open a folder, you 

see a window. When you write a letter, the document that you’re working on 

appears in a window. When you browse the Internet, Web pages appear in a 

window . . . and so on.

For the most part, windows are windows from program to program. You’ll 

probably notice that some programs (Adobe Photoshop or Microsoft Word, 

for example) take liberties with windows by adding features (such as pop-up 

menus) or textual information (such as zoom percentage or file size) in the 

scroll-bar area of a document window.

Don’t let it bug you; that extra fluff is just window dressing (pun intended). 

Maintaining the window metaphor, many information windows display different 

kinds of information in different panes, or discrete sections.

And so, without further ado, the following list gives you a look at the main 

features of a typical Finder window (as shown in Figure 2-2). I discuss

these features in greater detail in later sections of this chapter.

 

Figure 2-2: 
A typical 

Finder 
window in 

Mac OS 
X Snow 

Leopard. 
 

Close

Back button

Quick Look/Slideshow button

Action button

Search field

Hide/Show Toolbar button

Toolbar

Windows title

View buttons

Forward button

Minimize Zoom

Scroll barSidebar

Window resizer

Icon resizer
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 If your windows don’t look exactly like the one shown in Figure 2-2, don’t be 

concerned. You can make your windows look and feel any way you like. As I 

explain later in this section, moving and resizing windows are easy tasks. 

Chapter 3 explains how to customize certain window features. Chapter 5 

focuses on ways you can change a window’s view specifically when you’re 

using the Finder.

Meanwhile, here’s what you see (clockwise from top left):

 ✓ Close, Minimize, and Zoom (gumdrop) buttons: Shut ’em, shrink and 

place ’em in the Dock, and make ’em grow.

 ✓ View buttons: Choose among four exciting views of your window: Icon, 

List, Column, and Cover Flow. Find out more about views in Chapter 5.

 ✓ Quick Look/Slideshow button: Gives you a quick peek at the contents of 

the selected item. If more than one item is selected, it gives you a quick 

peek of one item and next and previous buttons so you can view the 

others slide show style.

 ✓ Action button: This button is really a pop-up menu of commands you 

can apply to currently selected items in the Finder window.

 ✓ Window title: Shows the name of the window.

 ✓ Search field: Type a string of characters here, and Mac OS X Snow 

Leopard digs into your system to find items that match.

 ✓ Hide/Show Toolbar button: Causes your computer to melt into a puddle 

of molten silicon slag. Just kidding! This button actually does what its 

name implies — hides or shows the toolbar (and Sidebar) of a window.

 ✓ Toolbar: Buttons for frequently used commands and actions.

 ✓ Window Resizer: Click and drag here to resize the window.

 ✓ Icon Resizer: Use this slide control to change the size of the icons in this 

window. (Note that this control only appears on windows in the Icon 

view, which you find out all about in Chapter 5.) 

 ✓ Scroll bars: Use the scroll bars for moving around a window.

 ✓ Sidebar: Frequently used items live here.

 ✓ Forward and Back buttons: These buttons take you to the next or 

previous folder displayed in this particular window.

  If you’re familiar with Web browsers, the Forward and Back buttons in 

the Finder work exactly the same way. The first time you open a window, 

neither button is active. But as you navigate from folder to folder, these 

buttons remember your breadcrumb trail so you can quickly traverse 

backward or forward, window by window. You can even navigate this 

way from the keyboard by using the shortcuts Ô+[ for Back and Ô+] for 

Forward.
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  The Forward and Back buttons remember only the other folders you’ve 

visited that appear in that open window. If you’ve set a Finder Preference 

so that a folder always opens in a new window — or if you forced a 

folder to open in a new window, which I describe in a bit — the Forward 

and Back buttons won’t work. You have to use the modern, OS X–style 

window option, which uses a single window, or the buttons are useless.

 This frosts me. If you hide the toolbar, the Sidebar is also hidden, whether 

you like it or not. Conversely, if you want to see the toolbar, you have no 

choice but to also see the Sidebar. So if you want to hide the toolbar and see 

the Sidebar, or vice versa, you’re out of luck. If I had my druthers, I’d hide the 

toolbar (which I rarely use) and keep the Sidebar (which I use constantly). For 

some unfathomable reason, Apple doesn’t allow that.

Top o’ the window to ya!
Take a gander at the top of a window — any window. You see three buttons 

in the upper-left corner and the name of the window in the top center. The 

three buttons (called gumdrop buttons by some folks because they look like, 

well, gumdrops) are officially known as Close, Minimize, and Zoom, and their 

colors (red, yellow, and green, respectively) pop off the screen. Here’s what 

they do:

 ✓ Close (red): Click this button to close the window.

 ✓ Minimize (yellow): Click this button to minimize the window. Clicking 

Minimize appears to close the window, but instead of making it disap-

pear, Minimize adds an icon for the window in the Dock. To view the 

window again, click the Dock icon for the window that you minimized. If 

the window happens to be a QuickTime movie, the movie continues to 

play, albeit at postage-stamp size, in its icon in the Dock. (I discuss the 

Dock in Chapter 4.)

 ✓ Zoom (green): Click this button to make the window larger or smaller, 

depending on its current size. If you’re looking at a standard-size 

window, clicking Zoom usually makes it bigger. (I say usually because if 

the window is larger than its contents, clicking this button shrinks the 

window to the smallest size that can completely enclose the contents 

without scrolling.) Click the Zoom button again to return the window to 

its previous size.

  Some people still call the Zoom button by its Mac OS 9 name, Grow.
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29 Chapter 2: The Desktop and Windows and Menus (Oh My)!

A scroll new world
Yet another way to see more of what’s in a window or pane is to scroll 

through it. Scroll bars appear at the bottom and right sides of any window 

or pane that contains more stuff — icons, text, pixels, or whatever — than 

you can see in the window. Figure 2-3, for example, shows two instances 

of the same window: Dragging the scroll bar on the right side of the front 

window reveals the items above Font Book and iCal and below Photo Booth 

and Preview, which you can see in the expanded window in the background. 

Dragging the scroll bar on the bottom of the window reveals items to the left 

and right, such as Exposé, iChat, iCal, and iTunes.

Simply click and drag a scroll bar to move it up or down or side to side. And 

yes, the scroll bars also look a bit gumdrop-like. As best as I can tell, Steve 

Jobs (Apple’s charismatic CEO) has a thing for gumdrops.

 

Figure 2-3: 
The same 

window 
twice; in 
the front 
window 
you use 

the scroll 
bars to see 
the hidden 
icons that 
are visible 

in the back 
window. 

 

Scroll area

Scroll arrows
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30 Part I: Introducing Mac OS X Snow Leopard: The Basics 

You can scroll in the following four ways:

 ✓ Click a scroll bar and drag. The content of the window scrolls propor-

tionally to how far you drag the scroll bar.

 ✓ Click in the scroll bar area but don’t click the scroll bar itself. The 

window scrolls either one page up (if you click above the scroll bar) or 

down (if you click below the scroll bar). You can change a setting in your 

General System Preferences pane to cause the window to scroll propor-

tionally to where you click.

  For what it’s worth, the Page Up and Page Down keys on your keyboard 

function the same way as clicking the grayish scroll bar area (the verti-

cal scroll bar only) in the Finder and many applications. But these keys 

don’t work in every program; don’t become too dependent on them. 

Also, if you’ve purchased a mouse, trackball, or other pointing device 

that has a scroll wheel, you can scroll vertically in the active (front) 

window with the scroll wheel or press and hold the Shift key to scroll 

horizontally. Alas, this horizontal scrolling-with-the-Shift-key works in 

Finder windows, but not in all applications. For example, it works in 

Apple’s TextEdit application but not in Microsoft Word.

 ✓ Click a scroll arrow at the top or bottom of a scroll area. By default, 

both arrows appear at the bottom of the scroll bar, as shown in Figure 2-3. 

You can set your General System Preferences so that you see one arrow 

at each end of the scroll area, as I explain in Chapter 3.

 ✓ Use the keyboard. In the Finder, first click an icon in the window and 

then use the arrow keys to move up, down, left, or right. Using an arrow 

key selects the next icon in the direction it indicates — and automati-

cally scrolls the window, if necessary. In other programs, you might or 

might not be able to use the keyboard to scroll. The best advice I can 

give you is to try it — either it’ll work or it won’t.

(Hyper) Active windows
To work within a window, the window must be active. The active window is 

always the frontmost window, and inactive windows always appear behind 

the active window. Only one window can be active at a time. To make a 

window active, click it anywhere — in the middle, on the title bar, or on a 

scroll bar. It doesn’t matter where you click, with one proviso: You can’t click 

the red, yellow, or green gumdrop buttons or the clear Hide/Show button of 

an inactive window to activate it.

Look at Figure 2-4 for an example of an active window in front of an inactive 

window (the Applications window and the Utilities window, respectively).
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